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Overview 

Introduction 

Journyx Reportlink™ is a robust reporting solution that allows you to tap into all the power and flexibility 
of Microsoft® Excel and Power BI pivot table and visual report building features.  Reportlink provides you 
with the ability to use Excel, Power BI and other third party business intelligence software to report on 
your Journyx data in real-time.   

About This Manual 

This manual contains installation and configuration instructions for the Excel add-into help you establish 
connectivity between the two applications and pull Journyx data into Excel.   

Configuring the web connection between Power BI (or other third party business intelligence tools that 
support web connections) is covered in a separate document.  Please contact your account manager or 
Journyx Support if you require the instructions for setting up a web connection between Journyx and your 
business intelligence software. 

A discussion of best practices or helpful tips is marked by a  symbol.   

System Requirements 

The Reportlink client add-in for Excel must be installed on a PC that has a fully-functional version of 
Microsoft Excel 2007 or later (referred to henceforth as “Excel”).  The Reportlink add-in is supported on 
both 32-bit and 64-bit versions of Excel. 

The Reportlink client add-in and Excel can reside on a separate PC or server from your Journyx server. In 
fact, this is recommended for optimal performance.  The Reportlink client add-in does not support 
Microsoft Excel when running in compatibility mode (e.g., Excel workbooks created in versions prior to 
2007 must be saved as .xlsx files in version 2007 or later before using Reportlink to refresh them).  The 
Reportlink client add-in also requires Microsoft® .NET, and it will automatically install it on your machine if 
you do not have it installed already. 

The creation of a web data connection is required to use Reportlink data in Power BI.  The is no client 
application to automate the connection process for Power BI at this time.  
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Reportlink Installation and Setup of Excel Client Add-in 

This section only applies to the Reportlink client add-in for Excel.  If you are setting up Reportlink for 
Power BI, creating a web connection is covered in a separate document.  Please contact your account 
manager or Journyx Support if you require the instructions for setting up a web connection between 
Journyx and your business intelligence software.   

This section assumes that your organization is running Journyx v11.5.4 or higher.  It also assumes that you 
have installed a supported version of Microsoft Excel on a local PC or Terminal Server.  Finally, you must 
have a license key that gives you access to Reportlink in the Journyx system.  Please contact your Journyx 
account manager for the required license key if you do not have access to Reportlink.  

Installing Reportlink on a Local PC 

Reportlink will be installed on the local PC or server where your Excel installation resides.  If an older 
version of Reportlink already exists on that same PC or server, you will need to remove it before you run 
the Reportlink installer file, as per Step 1, below. If you are installing Reportlink for the first time, you may 
skip to Step 2.   

Step 1:  Remove Older Versions of Reportlink 

Use the Add/Remove Programs feature in the Windows Control Panel to remove the older version of 
Journyx Reportlink (a restart may be required depending on your machine configuration).  

Step 2:  Get the License Key and Installer File  

Login to your Journyx system and go to Analyze→Export→Reportlink Exchange to download the current 
version of the Reportlink installer.  You must have access to the Analyze menu as part of your assigned 
role in Journyx in order to access Reportlink Exchange. 

Download the Reportlink.zip file. 

Step 3:  Run the Installer File  

Extract the Reportlink executable file from the Reportlink.zip file. 

Run the JournyxReportlink.msi file to launch the installer, which will automatically install Reportlink.  The 
Reportlink installer will also install the required version of Microsoft® .NET if it is not already installed on 
your PC or server.  NOTE:  Login to your Windows machine under your usual account when installing 
Reportlink.  It is not necessary to run the installer as a Windows administrator.  

By default, Reportlink will install and be added automatically to your active Excel Add-ins.  You can view 
the Add-ins by clicking on the Home menu, selecting Options, and selecting Add-ins from the menu on the 
left. 

 

 Occasionally it may be necessary to add the Journyx Reportlink.xlam file to your Excel Add-ins 
directory manually.  If you have finished installing Reportlink and the Journyx tab is not showing up in the 
list of Excel menus across the top OR the Journyx options look “grayed out” or “read only”, you may need 
to add this file and/or activate the Reportlink add-in.  In the 64-bit version of Excel, it is best to start with a 
saved file before pulling data from Journyx.  Saving the file will usually enable the options under the 
Journyx menu. 

To learn more about activating the Reportlink add-in, click here. 

https://community.journyx.com/support/solutions/articles/9000204327-journyx-reportlink-menu-option-in-excel-is-disabled
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If Reportlink does not appear in any of the Add-in lists, you may need to add the Journyx Reportlink.xlam 
file manually to the Windows directory where Add-ins are stored.  This location can vary, but it will usually 
look something like the following 2 examples: 

C:\Documents and Settings\Administrator\Application Data\Microsoft\AddIns 

C:\Users\mgan\AppData\Roaming\Microsoft\AddIns 

If the Journyx Reportlink.xlam file is not present in your Add-ins directory, please contact Journyx Support 
at support@journyx.com to get a copy of this file to add to your directory.  Once you have added the 
Journyx Reportlink.xlam file to your Add-ins directory, go back to the paragraph above and follow the 
instructions for activating an Excel Add-in. 

Loading Journyx Data in Excel 

You have the option to report on a wide variety of data in the Journyx system by accessing a list of 
available data “feeds” and loading them in Excel.  You also have the option to pull data from your 
standard and system reports in the Journyx system (see the Analyze menu in the Journyx system).  Once 
you have your file templates set up with your report settings and feed names, you can simply refresh the 
file at any time to pull real-time data from the Journyx system.  Each person who refreshes an Excel report 
template using Reportlink will only see the data (s)he is permitted to see in the Journyx system because 
Reportlink requires each person to enter Journyx account credentials to access the data.  

 

Loading the Initial Data  

In order to load any data from your Journyx system, you must enter your Journyx username and site 
location/URL in the Reportlink settings.  If your site uses SSL (this includes all sites hosted by Journyx), you 
must start the URL with https://….  The site URL must include the following information (in blue text) at 
the end of the URL:   

http://mysite.com/jtcgi/delimited.pyc  

After entering your username and site URL information, select the dates for the data you want to 
download by clicking in the box next to the Date Range label.  You can use any dates for which there is 
corresponding data in your Journyx system.  NOTE:  You MUST select both a start and end date for the 
data.  Leaving either date blank will result in an error.  The dates selected can be changed at any time you 
want to update the data, so your initial date selections are not critical. 

mailto:support@journyx.com
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You also have the option to update your report with only records that were added or changed since the 
last time you loaded data/refreshed your report.  This option is included in the Date Range download 
criteria box shown above. 

Once you have entered the connection and date range information, you can either start by loading data 
into a blank worksheet or use an Excel file that already has the report and feed settings included (a 
“template” file).   

Option 1:  Loading Data in a Blank Worksheet 

One of the easiest ways to test Reportlink connectivity and set up is to load time data into a blank Excel 
worksheet*.  After you have entered your connection and date range information, you can simply click on 
the Refresh button and enter the password for your Journyx account to download data from the time 
feed in both a pivot table and a sheet.  When downloading to a blank sheet, a pivot table and sheet 
renamed to “time” are automatically created. 

*In 64-bit versions of Excel, you may have to save the file/worksheet before you can enter your 
information and connect with Reportlink. 

 



Journyx Reportlink User Manual   
6 

 

If you want to build a report using the time feed data, you can continue from the initial load to build 
reports based on either the pivot table data, the sheet data, or both.   

If you want to download data from a different feed (or you want to limit the output to a pivot report or 
spreadsheet only), you can use the New button in the Journyx menu to set up a pivot report or sheet 
based on a selected feed.  See the Available Feeds and Data in Reportlink section of this user manual for a 
list of available feeds and a description of the data included in each feed. 
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After you click on the New button, a select list with all of the available Reportlink feeds will be displayed.  
You will also see your standard and system reports in the report list along with the data feeds. 

  When you create a new Journyx pivot table, select the feed or report name from the report list, 
choose the report type, and click Create.  Reportlink will refresh and download the data for your new 
pivot table or spreadsheet at that time. 

You can also add more pivot tables or sheets with other feed names to the same workbook using the 
same steps listed above.   

Option 2:  Loading Data in a Template File 

If you want to customize an existing report template before downloading your data from Journyx, you can 
make your changes and then click on the Refresh button when you are ready to load the data.  If it is the 
first time you have downloaded data using Reportlink, you will be required to enter the password or your 
API key for your Journyx account.  If your company uses single sign-on to login to Journyx, you can ask 
your Journyx Administrator to provide an API key for logging in via Reportlink.  Contact Journyx Support or 
your account representative for sample Reportlink templates created by Journyx. 

Updating the Data in Existing Reports/Template Files 

After you have built your report templates and loaded them with the initial data from Journyx, you can 
continue to update these reports by adjusting the dates and clicking on the Refresh button.  You can also 
distribute these templates to others in your organization.  If you don’t want to send the actual data you 
have loaded into a report template, you can click on the Clear Data button to delete the data while 
maintaining the report settings and configuration.   

Setting Up a Web Data Source in Power BI 

Configuring the web connection between Power BI (or other third party business intelligence tools that 
support web connections) is covered in a separate document.  Please contact your account manager or 
Journyx Support if you require the instructions for setting up a web connection between Journyx and your 
business intelligence software. 

Available Feeds and Data in Reportlink 

Reportlink includes a defined list of “feeds” that contain groups of related fields for building reports.  The 
list of available feeds is as follows:  time, expense, travel, time_compliance, expense_compliance, 
mileage_compliance, dailycompliance (DCAA only), rate (required rate rules), projectrollup (PX only), 
scheduledprojects (PX only), resource_availability (PX only), assignments (PX only), and 
actual_vs_projected (PX only).  A detailed description of each feed is included in the table below: 

 

Available Reportlink Feed Names Fields Available in This Feed 

time The time feed includes: Sheet Period Pname , 
Sheet Period Start, Sheet Period End, Sheet Period 
Level, Sheet Period State, Creator Login Name, 
Creator Full Name, Modifier Login Name, Modifier 
Full Name, User Login Name, User Full Name, 
Project Name, Project Description, Project ID, 
Total Estimated Hours, Percent Complete, Project 
Start Date, Project End Date, Activity Name, 
Activity Description, Pay Type Name, Pay Type 
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Description, Bill Type Name, Bill Type Description, 
ID, User, Date, Code, Subcode, Project, Hours, 
Comment, Committed?, Domainid, Other, Group, 
Creator, Create Time, Modifier, Modify Time, 
Level 1 Project ID, Level 1 Project Name, Level 1 
Project Description, Level 2 Project ID, Level 2 
Project Name, Level 2 Project Description, all 
custom User and custom Project fields in the 
system  

Notes:  The time feed contains all of the information included with a time record in the Journyx 
database – with the exception of any rate rule mark up.  Rate rule calculations for time records are 
included in the rate feed below.  This feed is good for reporting on time/actual work/hours grouped by 
project, activity, etc. on a daily, weekly, monthly, etc. basis. The data corresponds with the browser-
based Time Reports. 

expense The expense feed includes: Sheet Period Pname, 
Sheet Period Start, Sheet Period End, Sheet Period 
Level, Sheet Period State, Creator Login Name, 
Creator Full Name, Modifier Login Name, Modifier 
Full Name, User Login Name, User Full Name, 
Project Name, Project Description, Project ID, 
Project Start Date, Project End Date, Currency, 
Currency Name, Currency Description, Expense 
Code, Expense Code Name, Expense Code 
Description, , Source Name, Source Description, 
ID, User, Date, Extra, Flags, Project, Amount, 
Comment, Committed, Domain, Other, Group, 
Creator, Create Time, Modifier, Modify Time, 
Level 1 Project ID, Level 1 Project Name, Level 1 
Project Description, Level 2 Project ID, Level 2 
Project Name, Level 2 Project Description, all 
custom User and custom Project fields in the 
system 

Notes:  The expense feed contains all of the information included with an expense record in the 
Journyx database.  This feed is good for reporting on expenses users enter in Journyx. The data 
corresponds with the browser-based Expense Reports. 

travel The travel feed includes: Sheet Period Pname, 
Sheet Period Start, Sheet Period End, Sheet Period 
Level, Sheet Period State, Creator Login Name, 
Creator Full Name, Modifier Login Name, Modifier 
Full Name, User Login Name, User Full Name, 
Project Name, Project Description, Project ID, 
Project Start Date, Project End Date, Reason, 
Reason Name, Reason Description, Measurement, 
Measurement Name, Measurement Description, 
Vehicle, Vehicle Name, Vehicle Description, ID, 
User, Date, Extra, Flags, Project, Distance, 
Comment, Committed, Domain, Other, Group, 
Creator, Create Time, Modifier, Modify Time, 
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Level 1 Project ID, Level 1 Project Name, Level 1 
Project Description, Level 2 Project ID, Level 2 
Project Name, Level 2 Project Description, all 
custom User and custom Project fields in the 
system 

Notes:  The travel feed contains all of the information included with a mileage record in the Journyx 
database.  This feed is good for reporting on mileage users enter in Journyx. The data corresponds with 
the browser-based Expense Reports. 

time_compliance Full Name, <period start date> - <period end 
date> Status, <period start date> - <period end 
date> Amount, <period start date> - <period end 
date> Level 1 Approval Date, Level 1 Approver 
(assigned), Level 1 Backup (assigned), all custom 
User fields 

Notes:  This feed contains all of the time information that is available in the User Compliance Report 
under Approvals→Compliance→User Compliance. 

expense_compliance Full Name, <period start date> - <period end 
date> Status, <period start date> - <period end 
date> Amount, <period start date> - <period end 
date> Level 1 Approval Date, Level 1 Approver 
(assigned), Level 1 Backup (assigned), all custom 
User fields 

Notes:  This feed contains all of the expense information that is available in the User Compliance 
Report under Approvals→Compliance→User Compliance. 

mileage_compliance Full Name, <period start date> - <period end 
date> Status, <period start date> - <period end 
date> Amount, <period start date> - <period end 
date> Level 1 Approval Date, Level 1 Approver 
(assigned), Level 1 Backup (assigned), all custom 
User fields 

Notes:  This feed contains all of the mileage information that is available in the User Compliance Report 
under Approvals→Compliance→User Compliance. 

dailycompliance (DCAA tools only) The dailycompliance feed includes:  Approver 
Fullname, Approve ID, Approver Login, Date, 
Delinquency, User Fullname, User ID, User Login 

Notes:  The dailycompliance feed includes information on how late each user is for entering daily time 
by the deadline.  You must have the DCAA Toolkit for Journyx in order to set this daily time entry 
deadline. The data corresponds with the Daily Compliance report in the DCAA Toolkit. 

rate (requires rules and policies) The rate feed includes: Sheet Period Pname, 
Sheet Period Start, Sheet Period End, Sheet Period 
Level, Sheet Period State, User Login Name, User 
Full Name, Project Name, Project Description, 
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User Backup ID, Activity Name, Activity 
Description, Pay Type Name, Pay Type 
Description, Bill Type Name, Bill Type Description, 
Unique, Trec ID, Sequence, Start Time, End Time, 
Number of Hours, Rules Applied, Timesheet ID, 
Reserved, Project, Code, Sub-Code, Other Code, 
User Name, Date, Pretty Name, Domain, Pay Rate, 
Pay Rate Amount, Bill Rate 1, Bill Rate 1 Amount, 
Bill Rate 2, Bill Rate 2 Amount, Bill Rate 3, Bill Rate 
3 Amount, Level 1 Project ID, Level 1 Project 
Name, Level 1 Project Description, Level 2 Project 
ID, Level 2 Project Name, Level 2 Project 
Description 

Notes:  The rate feed includes time records and all of the pay and billing rate mark ups applied to those 
records.  The data corresponds with the browser-based Rate Reports. 

projectrollup (ProjectXecute only) The projectrollup feed includes: Project Record 
Type, Creator Login Name, Creator Full Name, 
Owner Login Name, Owner Full Name, Backup 
Owner Login Name, Backup Owner Full Name, 
Project Rollup ID, Project Rollup Timestamp, 
Project Rollup Project ID, Project Rollup Actual 
Work, Project Rollup Assigned Work, Project 
Rollup Labor Cost, Project Rollup Expense Cost, 
Project Rollup Percent Complete, Project Rollup 
Projected (Budgeted) Cost, Project Rollup Percent 
Budget Complete, Project Rollup Projected 
(Budgeted) Return, Project Rollup Projected 
(Budgeted) Profit, Project Rollup Projected 
(Budgeted) ROI, Project Rollup Current Cost, 
Project Rollup Current Profit, Project Rollup 
Current ROI, Project Rollup Actual Start, Project 
Rollup Actual End, Project End Date, Project Level, 
Project Id, Description, Parent, Creator, Loggable, 
Project Name, Owner, Backup Owner, Work 
Variance, Start Variance, End Variance, Duration 
Variance, Scheduled Work, Scheduled Start, 
Scheduled End, Scheduled Duration, Budgeted 
Cost, Budgeted Return, Budgeted Profit, Budgeted 
ROI, Hidden, Unassigned Work, Actual Duration, 
Level 1 Project ID, Level 1 Project Name, Level 1 
Project Description, Level 2 Project ID, Level 2 
Project Name, Level 2 Project Description, all 
custom User and custom Project fields in the 
system 

Notes:  The projectrollup feed provides all the rolled up totals for work and dates for scheduled 
projects.  Assignment work and dates rollup to the task.  Task work and dates rollup to the summary 
task and/or project. The data corresponds with the browser-based Scheduled Project Status Reports. 
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scheduledprojects (ProjectXecute only) The scheduledprojects feed includes: Project 
Record Type, Creator Login Name, Creator Full 
Name, Owner Login Name, Owner Full Name, 
Backup Owner Login Name, Backup Owner Full 
Name, Project Id, Description, Parent, Creator, 
Loggable, Project Name, Owner, Backup Owner, 
Work Variance, Start Variance, End Variance, 
Duration Variance, Scheduled Work, Scheduled 
Start, Scheduled End, Scheduled Duration, 
Budgeted Cost, Budgeted Return, Budgeted Profit, 
Budgeted ROI, Hidden, Unassigned Work, Actual 
Duration, Level 1 Project ID, Level 1 Project Name, 
Level 1 Project Description, Level 2 Project ID, 
Level 2 Project Name, Level 2 Project Description, 
all custom User and custom Project fields in the 
system  

Notes:  The scheduledprojects feed provides list-type information for Scheduled Projects.  Unlike the 
projectrollup feed, it does not include rollup actuals from assignment to task to project. 

resource_availability (ProjectXecute only) The resource_availability includes: Available 
Hours, Actual Hours, Date, ID, Assignment Name, 
Project ID, User ID, Utilization, Daily Load, User 
Login Name, User Full Name, Project Name, 
Project Description, Level 1 Project ID, Level 1 
Project Name, Level 1 Project Description, Level 2 
Project ID, Level 2 Project Name, Level 2 Project 
Description, all custom User and custom Project 
fields in the system  

Notes:  The resource_availability feed includes information on user assignments and availability.  The 
data corresponds with the information on Assignment Management and Resource Availability screens. 

assignments (ProjectXecute only) The assignments feed includes: ID, Assignment 
Name, Project ID, User ID, Utilization, Daily Load, 
Duration, Variance, Scheduled Work, Scheduled 
Start, Scheduled End, Scheduled Duration, Actual 
Work, Actual Work Updated, Actual Start, Actual 
End, Actual Duration, Estimated Work, Requisition 
ID, User Login Name, User Full Name, Project 
Name, Project Description, Level 1 Project ID, 
Level 1 Project Name, Level 1 Project Description, 
Level 2 Project ID, Level 2 Project Name, Level 2 
Project Description, all custom User and custom 
Project fields in the system  

Notes:  The assignments feed includes both user-based and project-based assignment details.  The data 
corresponds with the browser-based Assignment Reports.   

actual_vs_projected (ProjectXecute only) The actual_vs_projected feed includes:  Sheet 
Period Pname, Sheet Period Start, Sheet Period 
End, Sheet Period Level, Sheet Period State, 
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Creator Login Name, Creator Full Name, Modifier 
Login Name, Modifier Full Name, User Login 
Name, User Full Name, Project Name, Project 
Description, Activity Name, Activity Description, 
Bill Type Name, Bill Type Description, ID, User, 
Date, Code, Subcode, Project, Hours, Comment, 
Committed?, Domainid, Other, Group, Creator, 
Create Time, Modifier, Modify Time, Level 1 
Project ID, Level 1 Project Name, Level 1 Project 
Description, Level 2 Project ID, Level 2 Project 
Name, Level 2 Project Description, Scheduled 
Daily Work, Planned Project Rate Cost, Planned 
User Rate Cost, Actual Project Rate Cost, Actual 
User Rate Cost, Planned Project Billable, Planned 
User Billable, Actual Project Billable, Actual User 
Billable, all custom fields for Users, Projects and 
other time entry column fields in the system   

Notes:  This scheduled projects feed is designed to show forecasted and actual values adjusted for the 
reporting period.  It allows you to report on the specifics of planned and actual work for a sub-segment 
of a project (e.g., planned and actual work for month 3 only of a project). 
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